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Vav/. 4 Objectives ¥

« Be aware of Oracle's Application Development
Framework (ADF) standards-based applications

* Understand ADF development using advanced
graphical editing and declarative techniques

« Know ADF’ s Java and XML underpinnings
« See how JDeveloper creates ADF applications
« Grasp ADF BC’ s reusable data source support

* Learn how to build Uls graphically with drag and
drop components, and declarative properties
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A4y Who Am 17 'y

John King — Partner, King Training Resources

Providing training to Oracle and IT community for over
20 years — http://www.kingtraining.com

“Techie” who knows Oracle, SQL, Java, and PL/SQL
pretty well (along with many other topics)

Leader in Service Oriented Architecture (SOA) design
and implementation

Member of ODTUG (Oracle Development Tools User
Group) Board of Directors

Moved to Scottsdale, Arizona last year (we miss Colorado!)

Active member of Rocky Mountain Oracle Users Group
(RMOUG)

http://www.kingtraining.com 3 Copyright @ 2012, John Jay King



W Who Are You? ‘ﬁ/

* Forms Developer
* 4GL Developer
« Java Developer
All of the above
None of the above
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F? 'y

* Oracle Application Development Framework (ADF)
Is a Java-based development tool (much like Oracle
Forms is a PL/SQL-based tool) designed to take full
advantage of Java Enterprise Edition or Java EE

« Java EE is one of the most widespread application
environments today

« ADF’ s 4GL features make application development
much easier than normal Java “coding”

 Oracle is rewriting their ERP stack as “Fusion
Applications” using ADF; the already rich toolset
gets richer every day

Vav/. 74 Why Oracle AC

Training Resources

-
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A4y Do | Need to Know Java ? (ﬁ/

Training Resources

* Probably not well

— Someone with very basic Java and Web Skills
can easily create applications with ADF
(much the same as someone with basic PL/SQL
could create very basic Oracle Forms)

— Someone on your team needs to know Java very
well

— Someone on your team needs to know Groovy

¢ Someone on your team needs to understand ADF
and its available components very well
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Vav/ 74 Is Forms Going Away? ¥

Training Resources

* NO, NO, NO, NO, NO

* Oracle is committed to supporting Oracle Forms for
many years to come

* A new version of Oracle Forms (12c) is on the way!
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A4 What is ADF? T

Training Resources

« ADF is a “meta-Framework” interacting with a
variety of underlying software components
(including Frameworks) to provide:

— Database connectivity and transfer
— Mapping of application views to data sources

— Database interaction: constraints, keys, data types,
master/detail, null handling

— Data caching via entity objects

— Transaction management (locks, commit, rollback, etc...)
— Declarative validation

— Business logic and event handling

— User Interface (Ul) logic, flow, look & feel

— Data-bound Ul Components

— Ul properties including: formatting, colors, defaults, visual
components, LOVs, eftc...
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A2 ADF Technology Stack (ﬁ/

Training Resources

« ADF Technology simplifies interaction with “Java”
EE and Oracle’ s Fusion Middleware

Desktop Browser-Based )
(ADF Swing ) (_ Office ) (P ) ( JsF ) (CADF Faces ) View
B
&
Browser-Based
( struts ) (( JSF/ADF Task Flow ) Controller

3

( ADFBindings ) Model

MetaData Services (MDS)

Business
Services

Packaged Data_
Applications Services
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Vav/. 74 ADF: Two Major Pieces il
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 ADF has many parts but two are central to creating
applications

— ADF BC Business Components (data)
— ADF Faces Graphical User Interface
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A747  ADF Business Components (ﬁ/

Training Resources

* ADF Business Components (ADF BC) is a

framework that simplifies developing Java EE
business services

 ADF BC is part of the ADF Business Services layer
and is used to provide:

— Persistence and data retrieval with SQL using
data views

— Object-Relational Mapping (ORM) between Java
classes and database data

— Simplified data access, validation, and business
logic

— Transactional infrastructure
— Implementation of best practices
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Vav/. 4 ADF BC Objects ¥

Training Resources

 ADF BC is implemented using a variety of objects to:

— Define Insert-Update-Delete views to perform
gueries and data manipulation

— Define query views (read-only)
— Define links between queries
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A7%7 ADF BC - Component Structure (ﬁ/
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Application Module

View Object (VO) . View Object (VO)

Entity Object (EO) Entity Object (EO)

Entity Object (EQO) .

Database
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A4y ADF BC Components Iy

Training Resources

 ADF BC uses a variety of object types to represent data:
— Database tables and views Application Base Data

— Entity Objects Business rules, validations,
defaults for a table (or view)
— View Objects SQL output to query, filter,
join,modify, or sequence data
— Application Modules Use View Objects to

access/modify data acting as
a back-end data service

— Appl. Module Data Model Describes actual View
Object uses

* Objects may be reused in multiple Application Modules
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Sy ADF Data Binding 'y

Training Resources

 After identifying Entity Objects and View Objects two
additional ADF Data Model components are used

— Data Controls Java objects used to
abstract View Obiject
Business Services

— Binding Containers Java object; provides

data access to a single
ADF application page,
fragment, or activity
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A4 Java Server Faces (JSF) il

« Java Server Faces (JSF) is a Web-tier framework of
JSP technology and JSP Tag libraries to create and
use User Interface components

« JSF is extended by components of Oracle ADF
Faces

* JSF includes:
— Runtime architecture
— Library of JSF components
— JSF “Life Cycle”
— Many JSF-Oriented Files
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A4y ADF Faces (ﬁ/

Training Resources

« Even though JSF sought to simplify user interface; it
Is often felt to be too complex

 Oracle has extended JSF as “ADF Faces” providing
a set of libraries and tags that include enhanced Ul
components and easier use

* Oracle has presented ADF Faces to the Open
Source community where it is part of the Apache
Foundation Trinidad MyFaces project

http://Imyfaces.apache.org/trinidad/index.html
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Vav/ 4 Using ADF il
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* Using ADF Faces is simple using JDeveloper:

— Add Application layout containers to describe user
iInterface

— Add ADF Faces components to layout containers
— All Ul is done with ADF Faces; no HTML coding

* Features added by ADF Faces:
— Pop-ups and Dialog boxes
— Data Visualization Tools: Charts, graphics, etc...
— Declarative AJAX support
— More...
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A4y ADF Controller Iy

« The ADF Controller extends the JSF controller and
controls ADF's MVC (Model-View-Controller) in
ADF

* ADF Controller features include:
— Sequence of page displays (may be conditional)

— Allows partial-page processing in the same way
as full page processing; only the necessary part of
a page is rendered, the rest is unchanged

— Allows reuse of page parts
— Provides conditional control of page flow
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AZ47  ADF Faces “Rich-Client”  §

Training Resources

« ADF Faces is designed to create “rich-client” (RC)
interfaces; full-featured and declarative including:

— Complete JDeveloper support graphic
development (screen-painter) and property
palettes

— Visual Editor

— Property Inspector

— Changeable “skins” to easily alter look-and-feel
— Modifiable look-and-feel properties (declarative)
— Layout control
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Wa v/ 74 Oracle JDeveloper T
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« JDeveloper provides a world-class, easy to use IDE

* Oracle has extended JDeveloper beyond Java to
include:
— Oracle ADF modeling, business services, and GUI design
— XML edit including Syntax Checking & Schema Validation
— SQL development including debugging of stored PL/SQL
— UML Modeling and MDA (Model Driven Architecture)
— Web Services development
— ESB design
— BPEL design
— Portlets
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W Downloading JDeveloper il

« JDeveloper is Free!

* To learn more about JDeveloper, see Oracle's
website:

http://www.oracle.com/technetwork
/developer-tools/jdev/overview/index.html
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VAV 74 Oracle WebLogic Server il
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* Oracle WeblLogic Server is Oracle's preferred
platform to provide both a standard Java EE
environment and an environment specifically tailored
to Oracle Fusion Middleware; providing:

— Complete Java EE 5 compatibility
— Complete Java SE 6 compatibility

— Web Services support
— Integration with Oracle's Fusion Middleware tools
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Vav/. 74 Oracle AS and OC4J? i

« Oracle WeblLogic Server is the replacement for
Oracle Application Server (OAS) and OC4J

 OAS and OC4J are still supported and may be used
iInstead of WebLogic if desired but ADF requires at
least Java 1.5/ Java 5 (needed for ADF)

« To learn more about Oracle WeblLogic Server see
Oracle's website:

http://www.oracle.com/us/products
/Imiddleware/application-server/index.htm
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W Starting JDeveloper g

tthtart| @@ Oracle Fusion Middleware 11.1.2.1.0 »

& IDeveloper Studio 11.1.2.1.0

Oracle JDeveloper 11g
11.1.2.1.0
Productivity with Choice

ORACLE

Copyright ® 1997, 2011 Oracdle and/or its affiliates. All rights reserved.
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Training Resources

A7 JDeveloper - Select Role (ﬁ/

Select Role

Select the role that matches your requirements. You can also change roles
using the Roles page in preferences.

Role:

© Studio Developer (All Features)

Includes all features.

() Customization Developer

Configures the product for customizing metadata.

() Database Developer

Includes only features for core database development.

() Java Developer

Includes only features for core Java development.

(") Java EE Developer

Includes only features for core Java EE development.

Always prompt for role selection on startup

OK Cancel

&

http://www.kingtraining.com 26 Copyright @ 2012, John Jay King



JDeveloper - Start Page \

Training Resources

& Oracle JDeveloper 11g Release 2 =10 x|

File Edit Yiew Application Refactor Search Mavigate Build Run Versioning Tools Window Help

GoEa 90 XER Q0 - O & dkild wu- >-¥- Qv Search
P«pplication Mavigator X Q estart Page * E]

New Application...

(il

'/E—‘_ Open Application...

Oracle JDeveloper 11g

Learn how fto...

' Model Applications |

| Design Databases |

Build Applications

Integrate Applications

*=structure X
— D . . - - el A .
What's New |Release Notes | Samples | Discussion Forum | Books and Training | Online Resources

Mo Structure

ILoading model.Emp
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ﬁ; Exploring JDeveloper \

Navigator(s)

'~ Oracle JDeveloper 11g - JavaSamples.jws : JavaSamples.jpr : C: nce\mywork\Javas... lem
File Edit View Application Refactor Search Navigate Bu Source Versioning Tools Window Help Menu
(@ Application Navigator ) 2startPage | welcomelSp.jsp | (~) @ component Palette
& JavaSamples =R $e) ~ 5 JsP
~ Projects R T-E- 1| = ama>
& 191 JavaSamples B 2 < VelcomelJ5P.jsp > ® Pa Iette(s)
- Application Sources 3 JEmD> Attribute <
=] web Content 4 T <TITLE>Creating Hello World wi (I Body
® [Z) WEB-INF 5 | </MERD> € Dedaration
TestHtml.html 6 (i) EL Expression
Weloome)SP.jsp - 7 <% request.setAttribute(”title”, * © Element
- .- 8
o s = o L
. tly Opened Files 10 | (3 Fallback
haBaceotly,Opa 11| 5 <H1>Hello World!</H1> e - . 4
S — - — 12 Current time: <%= new java.util.Ds —_—
.= WelcomelSP.jsp - Structure ® 13/ = ©¥Head - Property Inspector
> H 14 <r><br> L G N )
. . ~ 15 = ‘
i [:JWammgs(l) 16/ <% for(imt 1 = 1:1 < S5:i+4) { %> ™ proﬁje;[ Property
o Inspector
A welcomelsp.jsp SFONT SIZE=<%=1%>>Hello Worl Internationalization
=@ Dir: | <default> )
[ scriptlet = [ ]V
=- (1l body ng:
=-€% h1
A Hello World!
A Current time:
Source | Design

C:\jdevinstance\mywork\JavaSamples\JavaSamples\public_html\Welcon :JSP.jsp| Line 3 Column 2 | nsert | | Win Xml Editing

Structure Displays

http://www Editor Area and Message Area



A2%7  Applications and Projects i
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« JDeveloper uses a non-standard, Oracle-specific
“Application” to group a collection of “Projects”
(similar to how it is done by other IDES)

« All files representing an “Application” share a
common root directory (folder) on a disk

 Many Applications may be open at once In
JDeveloper; but only one at a time will be visible In
the Application Navigator
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W JDeveloper Directory Structure (ﬁ/

&4 JavaSamples =] ¢
Fle Edit View Favorites Tools Help

O e i Folders ’ 4
Address |3 C:\jdevinstance\mywork\JavaSamples\JavaSamples ‘v Go

Folders X Name =

= [2) JavaSamples 0] DCiasses
= [ JavaSamples ggrt::bllc_html
= Q) ciasses =) JavaSamples.jpr
® | ) .data
® ) .wisjsps
() myClasses
£ samples
() spincup
) threadTests
= |53 public_html
() WEB-INF
2 ) src
(£ myClasses
) samples
() spincup
() threadTests
@ ) Project1Extra
= () classes
® ) .data
) samples
=@ 5 src

(£33 samples —4— o
http://wwiwkingtraining.com B 2emtibmns (3 —— 12 sht @ 2012, John Jay King
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W JDeveloper Editing \

« JDeveloper has many Code Editors & Visual Editors
including: Java, XML, HTML, JSP, JSF/ADF Faces,
BPEL, & more

(2)Start Page _|[F] DeptEmpPage.jspx | =
@) - show~|1024x768  ~|[@] None ~ | Default v[Nonev | A H 2 B F U = = 3%
| ORACLE [
— Show Detail ltem - Departments

Departments :H My Options v View v

#{...Departmentid...label} #{
#{...DepartmentName... #{

label} inj *{---EQS';;’””- #{. FirstName label} | #(..LastName.Jabel} | #{.Emaillabefy | *{-Phon
#{...Managerid...label} #{ .
#_Locationid._label} #{ 1_#{'..4f:impbyeeb? f{...FlrsthTf? f{L:thant) f{Em«:::} f{'.“Phone
First  Query  Previot ||z ¢ #7 e # 3 # Email #

#{...Employeeld...label}
#{...FirstName...label}
#{...LastName...label}

#{.. Email...label}
#{...PhoneNumber...label}
#{.. HireDate.. .label}
#{...Jobld...label}
#{...Salary...label}

Submit

...Employeeld.inputValue}
...FirstName.inputValue}

..LastName.inputValue}
...Email.inputValue}
..PhoneNumber.inputValue}
...HireDate.inputValue} E’EB
...Jobld.inputValue}
...Salary.inputValue}

b b SN RIS R R R R

|
jspiroot » fiview » afidocument#dl » af:form#f1 » afipagetermplate#ptl » f:facet

. .. Design | Source | Bindings | Preview | History | ¢ > [
http://www kingtraining.com o | = v LHistory SO T BT, o ey e




sz: JDeveloper Debugging

» JDeveloper allows local and remote debugging

& Oracle JDeveloper 11g - HRSystem.jws : ViewController.jpr
File Edit View Application Refactor Search Navigate Build Run Versioning Tools Window Help
Goag 90 XEm O -0 §- :hdida- b - - W-~EQ@EEDNT

Application Navigator = ‘\:’)Start Page DeptEmpPage.jspx =
— — — = =
[&] HRSystem ~|[@ -| | @ - show~ 1024 x 768 ~|[@] [none ~ | Default v[Nonev|A H £ B I U i= = 3=~
~ Projects M@=
@@ demo.view.pageDefs ¥ | ORACLE
{0 META-INF
=1 Web Content Departments My Options v View v
=3 WEB-INF . ..#..Departmentid._ label;
-3 adfc-config.xml H
Efaces—conﬁg.xml W *{"'E;‘igyee“' #...Fi label} | #{...1 label} | #{..Email label} #(...Ph?ar:
{3 search-email-flow.xml ~Hanagerid. . #{...Employeeld} #{...FirstName} #{...LastName}
{..Em {

#{...Locationid...
First Query

#{...FirstName}

#...Fir

#..L
#..L

[¢2] trinidad-config.xml
% web.xml
=+ Page Flows
-[E adfc-config

3+ 3

ADF Lifecycle Breakpoints x

[ search-email-flow Toggle breakpoints before and after phases.
DeptEmpPage.jspx v @ @ | JSF Restore View
» Application Resources Initialize Context
b Data Controls Prepare Model
b Recently Opened Files JSF Apply Request Values Jd.inputValue}
JSF Process Validations L inputValue}
= Structure EdStack  FEmA... =] JSF Update Model Values ‘-npuwa,ue)
Class Method Validate I:IIodeI IL_J[:od.ates b/alue)
E2 AdflLifecycleBre... markPhaseBoundal s IJ“SFt Izvt: e;:App |<i:tat|on r.inputValue}
[=] AdfLifecycleBre... maS$markPhaseBo... etadata O'Tm T 7Y
(=] AdfLifecycleBre... beforePhase Prepare Render
=] ADFLifecycleIm... beforePhase JSF Render Response alue}
& LifecycleImpl internalDispatchBef... Value}
[E] LifecycleImpl dispatchBeforePage...
[E] ADFPhaseListen... dispatchBeforePage...
[E] ADFPhaseListener beforePhase - o - - = e — T
=] ADFLifecyclePh... beforePhase ane!aocordnn#pa:!. b» af.ww#tallltgm#sdli » af:panelformlayout#pfll » af:par ge#pl 1)[>Dv
=] LifecycleImpl _executePhase " Design I Source | Blndlngs| Prewewl History | J
El LifecycleImpl  execute [Ellog  °Breakpoints  [¢SmartData |@IData |[lwatches |=sADFData |<=ELEvaluator (&
=] FacesServiet service i
El StubSecurityHel... run #- /Koo 25 g
(=] stubSecurityHel... invokeServiet Description Type
=l ServletStubImpl execute . ; ; . ;
= TailFilter doFilter @ !ava.lang.Except}on (uncaught), Persnsten? Exceptfon Breakpo!nt
=] FilterChainImpl ~ doFilter ~-@ java.lang.AssertionError (uncaught), Persistent Exception Breakpoint

[=] ADFBindingFilter doFilter @ Deadlock detection, Persistent Deadlock Breakpoint
= FiterChaintmpl _ doFier | before s Restore View —__________#oF iyl hose Breaigoint __________|
[=] RenictratinnFiltar dnFilter
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W JDeveloper Preferences f
NI ASSE——_ta—tbasat S titattt————_——

« JDeveloper is customizable; preferences may be
viewed/modified using Tools->Preferences

& Preferences x|
Q | Environment
@ [_] Save All When Deactivating or E
[#- ADF Business Components [v] Automatically Reload Externally Modified Files
Ant [v] Silently Reload When File Is Unmodified
[# Audit ] Check for Externa ed File tUD
[# Code Editor i
Compare Undo Level

Compiler Navigation Leve

Credentials
CSS Editor

4 Database Look and Feel Oracle -
Data Controls Panel Theme: Fusion Blue (Default) -
[} Debugger
[t} Deployment it
[ Diagrams
External Editor Line Terminator Platform Default v
| III' I‘ =S
Global Ignore List
Encoding: Cp12S2 -

Http Analyzer
JavaScript Editor Reset Skipped Messages
Java Visual Editor
(& ISP and HTML Visual Editor
Maven

h Mavna

Help oK Cancel
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W New Application ‘ﬁ/

* To create a new application use the JDeveloper
menu's File->New->General->Applications option, or
click Application Navigator -> New Application

é- Oracle JDeveloper 11g Release 2
File Edit WYiew Application Refactor Search

3oEd 9™ XEam 0 ¢
Application Mavigator X @

0 [

| New Application...

Open Application...
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>

Training Resources

New Gallery 'y

Available Items

Q Search

Cateqgories:

Items: [ ] Show all Descriptions

(=} General
Connections
Projects

(=} Business Tier
Web Services

Database Tier
All Ttems

http://www.kingtraining.com

Ar_—‘

5 Database Apphcation

@ Java EE Web Applcation

& uML Application

& Java Desktop Apphcation
m Application from EAR File

Apph.: ation Template

-

S Custom Application

@ Fusion Web Application (ADF)

Creates a databound ADF web application. The application consists of one project
for the view and controller components (ADF Faces and ADF Task Flows), and
another project for the data model (ADF Business Components).

S Java Desktop Application (ADF)
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A147 Application Structure i
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 When a JDeveloper ADF Web Application is created
ADF uses the MVC (Model-View Controller) pattern

« JDeveloper creates two subordinate projects
— Model Data and Business Rules
— ViewController User Interface

« ADF provides the “Controller”
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W File Structure ‘ﬁ/

* Review the directory structure created to support
the application and the associated projects

= 3 MyADFApplication
® ) .adf
® ) Model

) SIC
# [2) ViewController

=+
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AV How It Looks In JDeveloper

—» Oracle JDeveloper 11g - MyADFApplication.jws : ViewController.jpr =] l O m
File Edit View Application Refactor Search Navigate Buid Run Versioning Tools Window Help
CGoaag 90 XER 0 -O- T hidw- b &- (@8- Search )
Apﬁmﬁullhv'galnr | (=) (2)Build Applications  |(2)Start Page [&]MyADFApplication.jws [*) (@jResource Palette (9]
MyADFApplication ~ [&l ~|| show: All Projects~ ® 5 (@ ane ®)
~ Projects W V- ||| e summary: Total: 4 @ A @ «0k:4 Punc| ||b My Catalogs
Model | ||~ IDE Connections
Java Files Getting Started~ New~ - [ /| | XML Files Getting St Q Application Server
2 Web Content - - |
D Ashnal Overview The Java Files category contains java classes Overview The XML Files category contai @ Database
- DR Java Class and interfaces XML File
[ adfc-config.xml
[ faces-config.xml Java Interface
e &l trinidad-config.xml
H % web.xml
{2 Page Flows
I Application Resources Cue Cards | Tutorials | Detailed Help ~ | Cue Cards | Tutorials | Detailed Help \
b Data Controls {
b Recently Opened Files Page Flows Getting Started~ New~ - [ | Web Pages Getting St
= S | Overview Page Flows define an application's Overview The Web Pages cate
= ViewController.jpr - Structure Bl | se Page Flow web pages and navigation. JSF Page used to create the sc
ADE Task Flow 15P Page applications that use
ADF Task Flow Template HTML Page
Struts Page Flow JavaScript File
Style Sheet (CSS)
Enterprise JavaBeans 3.0 ADF Binding Files Web Services Offline Databases =l
Overview | <! | >
[ElFeedback - Log 5]
Messages | Feedback | W=

C:\jdevinstance\mywork\MyADFApplication\ViewController\ViewController.jpr
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W Create ADF BC Objects T

* The following pages show how to create ADF BC
objects using the Wizards provided by JDeveloper

« Each object created may be created individually
using JDeveloper's features or by coding them
manually rather than using the Wizards

« JDeveloper's database modeling capabilities are

shown to good effect by the use of Database
Connections and Wizards
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W Wizard-Based Development I

« The “Create Business Objects from Tables” Wizard
follows a few simple steps:

— Create Business Component, select type of
Business Component to be built

— Select Database Connection to be used
(may create Database Connection via Wizard)

— Build Entity Objects using database Tables/Views
— Build Updateable View Objects (if desired)
— Build Read-Only View Obijects (if desired)

— Save Application Module
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A7%7  New ADF BC Object: 1 f

 Start building new components as follows:

 Right-click on the application's “Model” project
and choose “New”

pra—.

K tew... Ctrl-N
Edit Project Source Paths. ..
| x Delete Py
i “ Find Project Files
I ':-hl'lﬁ vervie
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A7%7  New ADF BC Object: 2 |

 Choose Business Tier -> ADF Business
Components -> Business Components from
Tables from the “New Gallery”

& New Gallery X|
All Features  Current Project Features

This list is fitered according to the current project's selected festures

Q Search
Cateqories: Items: [ ] Show all Descriptions
& General (# Business Components from Tables

Applications

Connections
Deployment Descriptors
lava
Projects

(=} Business Tier

ADF Business Components

Data Controls

Security
Web

[z Client Tier

Database Tier
all Ttems

Help

Launches the Create Business Components from Tables wizard, which allows
you to create multiple entity objects and other Business Components from
database tables Use entty objects to represent tables or UML enttties and to
implement business rules. To enable this option, you must select a project in the
Application Navigator. Before you can finish creating the components, you will
be prompted to select (or create) a database connection,

AT Mo Mock
A

OK Cancel

http://www.kingtraining.com
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W Choosing Database Connection ‘ﬁ/

« Choose an existing Database Connection from the drop-
down list or build a new one by clicking the green plus sign
(Oracle client and tnsnames not required!)

é- Initialize Business Components Project 5‘

Select the database connection to use while developing your business components.

Connection: |adfsample v| +® Z
User Name: john
Driver: oracle.jdbc. OracleDriver

Connect String:  jdbc:oracle:thin:@localhost: 1521 :orcl

Select the SQL platform and data type map For your application. Mote that the data type map
cannot be changed once the project is initialized.

SQL Platform: ‘Oracle "
Data Type Map: ‘Java Extended For Oracle "
Help QK Cancel
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W Create Database Connection )\

& Create Database Connection 5'
Configure a new database connection and add it to the current application (MyADFApplication). a
Create Connection In:  (») Application Resources
Connection Name: dfsample l
Connection Type: [Oracle (JDBC) ']
Username: Ijohn l Role: I H
Password: |oooo I Save Password
- Qracle {(JDBC) Settings
[ ] Enter Custom JDBC URL
Driver: [thin ']
Host Mame: [Iocalhost | IDBC Port:  |1521
(@) sID: lorcl |
() Service Name:
Test Connection
Success!
Help QK Cancel
Y
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W Create BC from Tables, 1 v

« Add, verify, or alter package name as desired; verify Schema
to be used; modify filter (if desired) using SQL “LIKE” wild
cards; click “Query” to view accessible database objects

é Create Business Components from Tables - Step 1 of 6
Entity Objects
pecify the pack
@ Entity Objects )
| Package: |myadf.mode ‘ Browse. ..
Entity-based View Obje:
T le datab
] Schema: | JOMN w| Type Filter: OFF Filter Types
] Name Filter: |% ' | Auto-Query Query
heck the above ; i
ry" to popul his |
electing "Auto ( I
biects,
Your query settings will be remembered For this pane
Help MNext > Finish Cancel
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W Create BC from Tables, 2 g

« Choose the tables and/or views to be part of the Entity
Object and move them to the “Selected” side of the wizard

X

& Create Business Components from Tables - Step 1 of 6

Entity Objects

} Specify the package to contain your new entity objects and associations
Entity Objects ,
Package: |myadf.model ] Browse. ..

Shuttle database schema objects to the Selected kst to create entity objects

T Entity-based View Obje:
l
!
l

Schema: YJOHN - | Type Filter: OFF Filter Types
Name Filter: . [ ] Auto-Query Query
Available: Selected:
{tHH sonus £ DEPT
7
»
K4
&
Entity Name: |[Emp
Help Next > Einish Cancel
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W Create BC from Tables, 3 f

« After creating Entity Objects; the wizard offers to create
Updateable Entity-based View Objects representing the
output of SQL (to query, filter, join, modify, or sequence data)

& Create Business Components from Tables - Step 2 of 6

Entity-based View Objects

} Specify the package to contain your new view objects and view links

w Entity Objects

Package: |myadf.mode } Browse, .,
w Entity-based Yiew 0|
Shuttle entity objects to the Selected list to create view objects. If there is an association between selected entity objects, a

Ayailable: —
Dept (JOHN.DEPT)

T Query-based Yiew Obie(| view link will automatically be created
‘ Emp (JOHN,EMP)

>
»
<
<
Help < Back Next > Finish Cancel
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W Create BC from Tables, 4 T

« Select Entity Objects to be used by the view being
created; move them to the “Selected” side of panel

& Create Business Components from Tables - Step 2 of 6

Entity-based View Objects

M Specify the package to contain your new view objects and view links
w Entity Objects .
Package: |myadf.model ] Browse, .,

(w Entity-based Yiew 0! ;

| Shuttle entity objects to the Selected list to create view objects. IF there is an association between selected entity objects, a
T Query-based View Obie|l view link will automatically be

I Available: Selected:

DeptView (Dept)
l EmpView (Emp)

>
»
Help < Back Next > Finish Cancel
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/W Create BC from Tables, 5 f

 After creating Updateable Entity-Based View
Objects; the wizard goes on to create Read-Only
Query-based View Objects (used for List-of-Values)

© Create Business Components from Tables - Step 3 of 6 x|
Query-based View Objects
i Package: Iy adf.mode ‘ Browse. ..
w Entity-based View Obje:
T Shuttle database schema objects to the Selected kst to create query-based view objects
W Query-based Yiew 0
Schema: |JOMN - Type Filter: OFF Filter Types
Y Application Module
Name Filter: | Auto-Query Query
Check the above quer i
"Query" to I this |
Select ry" o
obje
Your g will b
Help < Back Next > Finish Cancel
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W Create BC from Tables, 6 f

 Name the Application Module and click Finish

& Create Business Components from Tables - Step 4 of 6
Application Module
¥ Optionally add instances of these default data model components to an application module. IF the application module does not
[ exist, it will be created.
[v] Add to Application Module
 Query-based View Obje Package: Imyadf.model ] Browse. .,
W Application Module Name:  |AyADFAppModule I Browse. ..
T Diaqram
Help < Back Next > Finish Cancel
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W Business Component Files ‘ﬁ/

* Note the use of XML to declaratively support ADF
BC

{=lapplication Navigator * ‘ (=] &) MyADFapplication
» MyADFApplication = M | Projects
~| Projects Q@ V- E-~ =[5 Model
=-0] Mode! . =-{_) Application Sources
- =-{_] Application Sources =)@ myadf.model
=)@ myadf.model =k {ﬁ AyADFAppModule
iﬁ AvADFAppModule ------ iﬁ AyvADFAppModule. xml
s @ 2T Yo
- 82] Deptview Lz pept.xml
i @ Emp B E] DeptView
I L2, Empdeptnofkassoc R . &2 Deptview. xml
ﬁ f‘] EmpdeptnofkLink EI @ Emp
. ﬁl EmpView N @ Emp.xml
....... 3 Model. jpx =57, Empdeptnofkassoc
f 5 ------ 2, Empdeptnofkassoc, xml
= fél Empdeptnokalnk
j ------- fé | EmpdeptnofkLink.xmi
EI & EmpView
L &) Empview.xml
--£%5 Model.jpx
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A747 Business Component Browser

Training Resources ‘ ]\

« JDeveloper provides
a tool to “browse”
ADF BC Application
Module objects
graphically; using the
Application
Navigator, find the
Application Module
to be viewed; right-
click and choose
“Run” to start

http://www kingtraining.com

{Zlapplication Navigator * -] (2)sStartPage x [Fv
MyADFApplication =R f Checklist
-] Projects DT = ‘
=-18)] Mede!

=1 Application Sources

| JavaFiles
Page Flows

Managed Beans

=@ myadf.mode Web Tier
‘_' l? L s~ LR |
-
4 E R¢ N
(4
4 C':' X O
4 E'; -
B
N
“
= ['A] View (ot
( catio Lesd
| Application Resq Make Ctrl+Shift-FO
- {—l Connectios gg Rebuild Alt+Shift-F9
= a, Datab
- a -
=] Data Controls * Debua
Compare With >
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W Component Browser Choices ‘ﬁ/

* Choose the Business Component to be tested
NI=E

File View Create Database Help

|

ﬁ AvADFAppModule

=-$2] Deptview!

E}'-fﬂ EmpdeptnofkLink1
-89 Empyiew2

L S’.'f] EmpViewl

Mame: AyADFAppModule.EmpdeptnofkLinkl Definition:myadf.model. EmpdeptnofkLink
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Vav/ 74 Component Browser — Display, 1 (ﬁ/

Training Resources

« Oracle’ s Business Component Browser displays
data from the underlying database objects
(screen should look familiar to Oracle Forms users)

* If referential keys are defined in the database
(Primary Keys and Foreign Keys) the ADF BC
Wizard automatically arranges the tables into a
Master-Detall relationship
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Vav/ 774 Component Browser — Display, 2 )\

Training Resources

B3 oracle ADF Model Tester (AyADFAppModuleLocal-Local) =10| x|
File View Create Database Help

| )

ﬁ AyADFAppModule g@ EmpdeptnofkLinkl |

=152 Deptview1

: E}g?} mpdeptnofkLink1 € € > 4 x @ @& R & P
bl -

32| EmpYiew2

o S’.-f] EmpViewl

Deptno |10
Dname |ACCOUNTING
Loc |NEW YORK

€ € 2 A XD B B &P

Empno Ename Job Mar Hiredate Sal Comm Deptno
7839 KING PRESIDENT 1961-11-17 ... 5000 10
7934 |MILLER CLERK 7762(1962-01-23 ... 1300 10

MName: AyADFAppModule. EmpdeptnofkLinkl Definition:myadF.model.EmpdeptnofkLink
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Vav/ 7 Searching Data

Training Resources

« Use the “Specify View Criteria” (Binocular) icon
to Search Ec)

Eﬂracle ADF Model Tester {AyADFAppModuleLocal-Local) = |I:I|5]
File Yiew Create Database Help

|

[l AvADFAppModule 2 EmpdeptnofkLink |

=52 Deptview!

E},:]‘W K¢S 2N+XBBWVY P

" fg] EmpYiewl

Deptno |20
Dname |RESEARCH
Loc |DALLAS

€ ¢ 2 A XD D @ ¥ P

Empno Ename Job Mar Hiredate Sal Comm Deptno
7566 |JONES MANAGER 7839(1981-04-02 ... 2975 20
7788/5COTT ANALYST 7566|1957-04-19 ... 3000 20
7876/ADAMS CLERK 7788(1987-05-23 ... 1100 20
7902 |FORD ANALYST 7566|1951-12-03 ... 3000 20

MName: AyADFAppModule. EmpdeptnofkLinkl Definition:myadf.model.EmpdeptnofkLink
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Sy Search View Criteria f

Training Resources ‘

e Enter Search criteria and click “Find”
Erewcena 5

Select predefined criteria, or define ad hoc criteria
~Predefined criteria:

Available: Selected:

22z~

~#Ad hoc criteria:
Criteria |
Enter an operator followed by a value:
Deptno: |
Dname: |
Loc: [DaLLAS|
EmpView: |

Find OR>> Remove Remove Al Cancel | Help |
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Vav/ 74

Training Resources

earch Results

Oracle ADF Model Tester {(AyADFAppModuleLocal-Local) - |I:I|5|
File WYew Create Database Help
ﬁ gADFApPModuIe ?."{J EmpdeptnofkLink1 |
=32 Deptiew! —
: E}g_e] EmpdeptnofkLink1 € € 2 I # x @ a “ &
o EmpYiew?2
o ?.-9] EmpYiewl
Deptno |20
Dname |RESEARCH
Loc |DALLAS
€ ¢ 2 AP XD A B P
Empno Ename Job Hiredate Sal Comm Deptno
7566 |JOMNES MANAGER 7839|1981-04-02 ... 2975 20
7788|5COTT AMNALYST 7566(|1987-04-19 ... 3000 20
7876|4DAMS CLERK 7788(1987-05-23 ... 1100 20
7902 |FORD ANALYST 7566(1981-12-03 ... 3000 20

Mame:AyvADFAppModule. EmpdeptnofkLinkl Definition:myadf.model. EmpdeptnofkLink
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A7Z%7 Browsing Database Objects

ning Resources

JDeveloper’ s Database Navigator allows browsing
of database objects

(parts of Oracle's SQL Developer tool have been
incorporated into JDeveloper)

©lapplication X a[latabase Navigator X -] (PstartPage X | =MyADFApplication Overview X | |3)adfsample (MyADFApplication) X |EEHEMP. X

P |
% @ 2 7 @ ~ actions...
(@ TDE Ca @ COLUMN_NAME | DATA_TYPE d NULLABLE [DATA_DEFAULT (g ~ZC-LI_Ir'-'1r'-J_IE'“§] COI‘-’II‘-’1EI‘-JTS‘
(=) [f) MyADF ;;I ki NUMBER (4 N ull 1 (null)
= ld dfsample RC} ] > (null)
(=) !j lll’llllll [|l,»|p<.].| O 1 ) I:lllll | :I
@ sonus 11 } (null}
" gla}d nul ) 4 nu |
- DEPT : :
-8 Evp TE 1 § {null)
{8 EMPNO JMBE 6 (nall)
{8 ENAME COMM TMBE 7 {nuall)
{108 DEPTHO nEE 8 (null)
R o
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A4y Modification of Application g

Training Resources

* Once the initial Business Components are created in
the application, it might be useful to:

— Set default values
— Define formatting
— Validate data
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W Object Properties f

* Like Oracle Forms (and other 4GLs) properties are

listed
% Hiredate - Property Inspector | =)
H I E (I ric $4)@
= VI Hints P
@ Label: Hire Date N
@ Tool Tip: Hire Date dd.mm.yyyy b2
Control Type: [<defaurt> vJ v
Display Hint: [<default> (Display) v] v
Display Width: ~
Display Height: ~
@ Format Type: |at.DefaultDateFormatter vJ ~
Format: dd.MM.yyyy| vl v []
Form Type: [<defau|t> (Detail) v] ~
Auto Submit: [<default> (false) q 2

Custom Properties
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W Properties in XML Files \

« ADF uses XML files to store declared definitions

(2)Build Applications  |(2)Start Page |£§]MyADFApplication.jws @Enp.xni §
(@ (X))

70| B <Attribute

71 Name="Hiredate"

72 ColumniName="HIREDATE"

73 SQLType="TIMESTAMP"

74 Type="oracle. jbo.donain.Date"”

75 ColumnType="DATE"

76 TableName="EMP">

77 <TransientExpression>:<![CDATA[adf.currentDate] ]></TransientExpression>-

78| = <DesignTime:-

79 <Attr Name="_DisplaySize”™ Value="7"/>

80 < /PDesignTime

81 = <Properties:

8z = <SchemaBasedProperties:

83 = <LABEL

84 ResId="myadf.model.Enp.Hiredate_ LABEL" />

85 = <TOOLTIP

g6 ResId="myadf.model.Enp.Hiredate TOOLTIP"/>

87 = <FMT FORMATTER

88 ResId="myadf.model.Emp.Hiredate_ FMT_ FORMATTER" />

89| = <FMT FORMAT

90 ResId="myadf.model.Emp.";’>

9l </SchemaBasedProperties:-

a2z </Properties:

93 </Attribute>

94| B <«Attribute

95 ) Name="5al" M
overview | Source | History | ¢ 4l |
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A7#27 Modify Appearance & Formatting

« Use JDeveloper to modify appearance of database
column values by double-clicking an Entity Object

Application Navigator Xl =)
= MyADFapplication v!| [ .j
~| Projects Rl V&~
=-{] Model

=) Application Sources

=@ myadf.model
Eliﬁ AvADFAppModule
&]@ Dept
EIE] DeptView
- (eg) S
#- 0% Empdeptnofkassoc
Er]fa] EmpdeptnofkLink
EJE] EmpVYiew
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Training Resources

& Oracle JDeveloper 11g Release 2 - MyADFApplication.jws : Model.jpr : C:\ JDeveloper\mywork\MyADFApplication\Model\src\myadfimodel\Emp.xml
File Edit View Application Refactor Search MNavigate Buld Run  Versioning Tools Window Heb

GoEg 9290 XER O0-0- & ald aa- > -%-4 Q- { Search
Application Navigator X E] v\:")Start Page X |§MVADFApphcatlon Overview X l@ﬁw ll E]

w | (=5 —
£ | (&l MyaDFAppiication ~ & - ©) 2
[l
c | =l Projects BT E-
@ General
| &3] Model = Entity Object
=-{23 Application Sources M| Attributes 2 oblects & R dotads for vour b e
& myadf.model Business Rules Entity objects are used to enca ate the business logic and database storage details for your business entities.
- (il AvADFAppModule Java Nare: Emp
- Dept Business Events
@) Deptview S : Package: myadf.model 7
@ E View Accessors
& e Extends: <None> /
] C‘d Empdeptnofkassoc o
7] ﬁ] EmpdeptnofkLink Property Set: <None> /
# E] EmpYiew
143 Model. jpx $ Schema Object: EMP 7
=) Application Resources
@ u] Procedures T Business Components Project: Mode

(¥ (@ Public Database Links

|_-fj }% l-‘u'hllr. Synonyms [+ Alternate Keys */7%
7] Schemas
([ 38 Sequences i+ Tuning |
(@ {&F Synonyms N
=18 ET;;I;» . M [+ Custom Properties + 7%

! O =)

gg ;E/;T [+ Security: Emp

1! Lm f-ileLbRM‘E [+ Business Logic Groups + / L
@ ablespaces )
()-8 Triggers

@-{3 Type Bodies
.28 Tunes
-l Data Controls o7

Overview i 4 4
[FM7Y sy ADF AppModuleDataControl B ——

Q Actions ¥

(10U ####® UWSLYyLULLISCOLI0M. L4001 U suws L

-

zce
[161) #8888 QueryCollection. finl no RowFilter

[162]) Fail during disconnect.
Feb 7, 2012 7:32:2Z PM
INFO: BC4J Tes
Process exited with

te exitc

exit code 0.

O
Messages

+| Recently Opened Files

> Running: Model.jpr > 4=

oading myadf.model.Emp

Y.

http://www.kingtraining.com 64 Copyright @ 2012, John Jay King



Entity Object Attributes

Training Resources

& Oracle JDeveloper 11g Release 2 - MyADFAppli n.jws : Model.jpr : C:\ JDeveloper\mywork\MyADFApplication\Model\src\myadf\model\ Emp.xml
File Edit Yiew Application Refactor Search Mavigate Build Run  Versioning Tools Window Hebp

BB.Q‘Q@‘X-. Q-O- ﬁa‘ - p>-F- A Q~( Search

‘Application MNavigator X [;] ‘\;’)Start Page X |EMyADFApphcatnon Overview X [@ﬁmﬂlﬂ Kl E]

v S = . A
§ [ MyADFapplication v v @ =
: S et del W}V E General
-] Model - e Attributes Set Source Order
=23 Application Sources ~ ributes
=@ myadf.model Business Rules Entity attributes can be based upon columns in the schema object or can be based upon transient values.
(il AvADFAppModule Java - X
Name v Override
G- g Dept Business Events 2
@ Deptiiew Name Column Name Column Type Extends
View Accessors
o @ T R T —
) K
[; ?]9 Emp:ep:m:fsfm v Ename String ENAME YARCHARZ(10)
mpaeptnol Nk
& é] Emz\/le‘z\l Job String 308 VARCHAR2(9)
% Model. jpx & Magr Integer MGR NUMBER(4, 0)
=) Application Resources Hiredate Timestamp HIREDATE DATE
- (] Procedures 1 Sal BigDecimal saL NUMBER(7, 2)
(# (@ Public Database Links Comm BigDecimal COMM NUMBER(7, 2)
() [ Public Synonyms Deptno Integer DEPTNO NUMBER(2, 0)
(@[ Schemas W
@[ 3@ Sequences
S g }'Y:rr'."ms Details Ul Hints  VabdationRules ~ Securty  Dependencies  Custom Properties
= ables ~
g E;‘PN;JD Name : :Err.pr.c- Updatable: {Always -
)| B Y
{tH Emp Display Name: [Empno ) @) Persistent () Transient
SALGRA escription: | ] .
-2 fn;)mup bE Description: | J [¥] Mandatory [7] rRefresh on Insert
ablespaces W r \
(- (18 Triggers Type: Integer - 7 v k [] Refresh on Update
@ (3@ Type Bodies Property Set: |<None> - Queryable [7] Change Indicator
. 28 Tunee 4
= Data Controls N7 Default Value v i e
Overview | Di i < »
RIS YAy ADFAppModuleDataControl Overview |[BRSOrEm|SOUFCS RSt ||
Q Actions v
[XUUT ####¥ YUEL yOULTCCCIUN: TIUT 1O -
[161] #$$88 QueryCollection. finl no
[16Z] Fail during disconnect.
Feb 7, 2012z
INFO: BC4J Tester t
Process exited with exit code 0.
-+ Recently Opened Files O -
Messages b Running: Model.jpr =

oading myadf.model.Emp
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Training Resources

File Edit ‘Yiew Application

Goag 90 XEEm O0-0- EXE BE N

Application Mavigator X

Refactor

& Oracle JDeveloper 11g Release 2 - MyADFApplication.jws : Model.jpr :

Search

)

[ MyADFApplication

vv<

=l Projects
-3 Model
=-{22 Application Sources
=@ myadf.model
@-{ill AvADFAppMadule
e7] @ Dept
@ DeptView

- (g Emp

2n3Pn4s

@ &) EmpdeptnofkLink
-5 EmpView
L & Madel. jpx

=) Application Resources

(@ (] Procedures

{L@ Public Synonyms
{@ Schemas
{38 Sequences
{9 Synonyms
{3 Tables
i BONUS
{E# pepT
) EmP
{8 sALGRADE
([ Tablespaces
() [ ® Triggers
@38 Type Bodies
. 28 Tunes
=l Data Controls

R I7; YA vADF AppModuleDataControl

r]
[
4
[+
4
=

| Recently Opened Files

oading myadf.model.Emp
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QR Y-

- 5B, Empdeptnofkassoc

55.-

{8 Public Database Links

'

-\ JDeveloper\mywork\MyADFApplication\Model'\ src\myadf\model\Emp.xml
Versioning Tools Window Help

>-&F- A
‘\:’)Start Page X |§MyADPApplicat'mn Overview X Xl

Mavigate Build Run

Search

Q-

General
Attributes

Business Rules

Business Rules

Java

Q Find
Emp
{23 Entity validators
3 attributes
& Database Constrant
& Database Co
&8 Ename

&# Database Constrant
&8 Job

& Database Constraint -
(@ Mor

&& Database Constraint -
(58 Hiredate
i Sal

§& Database Constraint -
@8 Comm

&# Database Constraint
(538 Deptno

&# Database Constraint

Y- a4 7/ R Set Execution Order...

Business Events

View Accessors

()

- Mandatory

nstraint - Precision :

- Precision

Precision : (¢

Precision

Precision : (7,2)

- Precision :

- Precision : (2,0)

iove’wew‘ Diagram Source History <

Erunning: vecel - oo x I e
Q

(S SEIEp)

Actions ¥

-

[162] Fail during disconnect.
Feb 7, 201z 22
INFO: BC4J Tester

Process exited with

7: PH

0.

O
Messages

> Running: Model.jpr
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Vav/ 7 Validations and Business Logic (ﬁ/

Training Resources

« Validations and Business Logic may be added
iIncluding:
— Client-side validation
— Format masks
— Default Values
— Declarative Range (and other) Validation
— CSS (Visual Attributes)
— List of Values
— Calculated field
— Code Validation
— Extensible for complex application validation
— Transactional Triggers
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Wav/ 724 Validation Rules \

Training Resources

& Add validation Rule for: Sal x|

Define the Validation vou want to perform with this rule and configure the Yalidation Failure response.

Rule Type: [Range 'l

Rule Definition  Validation Execution  Failure Handling

Operator: [Between v]

Range

Minimum Yalue: lSUD |

Maximum Yalue: IE'UUU l

Hint: Enter valid values for the selected attribute's bype,

Help oK Cancel

&
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/W Validation Error Messages \

& Add Yalidation Rule for: Sal X|

Define the Validation you want to perform with this rule and configure the Validation Failure response.

Rule Type: [Range ']

Rule Definition ~ Validation Execution  Failure Handling

o

Yalidation Failure Severity (3) Error () Informational Warning

Failure Message

Enter text for the translatable validation failure messages.

Message Text: Q
Salary should be between 500 and 6000

Token Message Expressions:
Message Token Expression

Hint: to add a token message expression, include a token of the form {0} in your error message
string.

Help OK Cancel
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W Attribute Defaults i

@Hiredate-Property Inspector X E]
* Using the Property &1/ aQm B
[ JEUUETIE Ty [<Oerauic= (raise] T
Inspector, open the
[] Mandatory Updatable: [Always v]

“ Va I u e 7 p ro p e rti eS a n d Default Value Type: () Literal () Expression () SQL

o Default Yalue:

set the default value (in R 1/

Refresh Expression Yalue:

this case “adf.currentDate” | |

=] Database

using ADF’ s “Groovy” O <

rt o Column Type *: DATE |
S u p p O ) Primary Key: [(default> {false) 'l v
Persistent: [(default> {true) 'l v
Queryable: [(default‘; {true) 'l v
Refresh on Update: [<default> (false) " v
Refresh on Insert: [<default> (false) 'l v
Change Indicator: [<default> {false) '] v
Track Change History: [<default> {MonHistory) '] v
Precision Rule: Itrue ]

Date Effectivity

Unique: [(default> {false) '] N7
[~ UI Hints
o Label: |Hire Date | v
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£Z7  AtrbuteFormatting

° : ' '@Hiredate - Property Inspector * (=)
Use an Attribute's Property | mroimsecer L
Palette "Ul Hints™ section  [avre
to control formatting, label, |=vale
tool tip, etc... (note this HDatslase
. =/ UI Hints
formatting uses Java - Labet — §
S|mp|eDate FO 'm at Opt'OﬂS) o Display Mame {Plural): |Hire Dates v
@ Tool Tip: Hire Date yyyy-MM-dd v
Control Type: <default > 7’ v
Display Hint: <default> (Display) V’ B
Display Width: v
Display Height: v
@ Format Type: Simple Date 7’ v
o Format: yyyy-MM-dd v| v
Form Type: <default> (Detal) v | v
Auto Submit: ‘ <default> (false) V’ v
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A7%7 What Does the XML Look Like?

<Attribute
Name="Hiredate"
ColumnName="HIREDATE"
SQLTy e="DATE"
?e— ‘oracle. jbo.domain. Timestamp”
umnType="DATE"
Tab1eName-"EMP
pefaultvalue="adf.currentbate">
<Properties>
<SchemaBasedProperties>
<LABEL
ResId="myadf.model.Emp.Hiredate_LABEL" />
<LABEL_PLURAL
ResId="myadf.model.Emp.Hiredate_LABEL_PLURAL"/>
<TOOLTIP
ResId="myadf.model.Emp.Hiredate_TOOLTIP" />
<FMT_FORMATTER
ResId="myadf.model.Emp.Hiredate_FMT_FORMATTER" />
<FMT FORMAT
ResId="myadf.model.Emp.Hiredate_FMT_FORMAT" />
</Schema8asedpropert1es>
</Properties:
<SATTributes

http://www.kingtraining.com 72 Copyright @ 2012, John Jay King



W Date Mask Properties File (ﬁ/

fE5] ModelBundle properties ‘
# -
myadf.model.Emp.Sal_Rule_O=Salary should be between 500 and 6000
myadf.model.Emp.Hiredate_LABEL=Hire Date
myadf.model.Emp.Hiredate_TOOLTIP=Hire Date dd.mm.yyyy
myadf.model.Emp.Hiredate_FMT_FORMATTER=oracle.jbo.format.DefaultDateFormat
myadf.model.Emp.Hiredate_FMT_FORMAT=dd.MM.yyyy
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Vav/ 74 Comparison to Oracle Forms i’

Training Resources

* |n Oracle Forms we defined “data blocks” that
represented tables and views that would be used in
our forms

« ADF BC components do that and more, plus they
may be shared by many applications

* |n Oracle Forms once the “data block” was created
we would then use it to create the presentation

 With ADF we use ADF Faces to accomplish the
same thing and more
(again creating components that may be reused by
other applications)
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Vav/ 4 Comparison to Typical 4GLs ~ fi

Training Resources

« Most 4GLs offer some type of “Data Object” or
“Data Access Object” capability

— Usually include wizard-based development

— Usually work with relational database; do not
usually support procedure-based data

— Sometimes provide ability to find and link data
objects using database dictionary

— Sometimes provide stand-alone reusable data
objects

— Sometimes linked to GUI development via “drag-
and-drop” capability

http://www.kingtraining.com 75 Copyright @ 2012, John Jay King



Vav/ 4 Creating Web Applications i

Training Resources

Oracle’ s Business Component Browser is
iImpressive, but hardly a customer-facing interface

ADF Faces extends the Java Server Faces (JSF)
framework using XML tags to describe the Ul

ADF Faces provides a Rich-Client Interface that
uses JavaScript and AJAX components; users must
have a reasonably up-to-date browser (Internet
Explorer 7.0 or higher, Mozilla Firefox 2.0 or higher,
Safari 3.0 or higher) to use all of its features

ADF Faces is designed to make creation of “rich-
client” (RC) interfaces full-featured and declarative
where possible
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A147 Review of Web Processing (ﬁ/

Training Resources

6 Faces Servlet b

Life Cycle
Phases:
123
456

HTML

Backing
Bean

Web Browser Application Server
with (HTTP Server)
HTML page
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A4y HTML, CSS, and Forms i

Training Resources

* Even though the ultimate page delivered to the
Client Browser is HTML; with JDeveloper's Visual
Editor and the combination of ADF Faces and JSF
Faces it uses to create .jspx pages there is little
need for ADF Developers to code HTML or CSS

\/

* Yield to JDeveloper's declarative mechanism and
refrain from coding
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A4y ADF Controller Iy

Training Resources

« The ADF Controller extends the standard JSF
controller and controls the MVC in ADF

* ADF Controller features include:
— Sequence of page displays (may be conditional)
— Allows partial-page processing in the same way
as full page processing; only the necessary part of

a page is rendered, the rest is unchanged
(makes page processing faster)

— Allows reuse of page parts
— Provides conditional control of page flow
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Vav/. 74 JSF Life Cycle iy

Training Resources

« JSF (and ADF Faces) follows a predictable cycle:

Restore Components
Apply Request Values
Process Validations
Update Model Values
Invoke Application
Render Response

2L o

* This Life Cycle is normally transparent; however, it is
useful to understand it when debugging
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W JDeveloper Visual Designer I

» JDeveloper's Visual Designer may be used to
“paint” a User Interface using the Component
Palette

« The JDeveloper Visual Designer is intended to be
WYSIWYG (What You See Is What You Get);
however the nature of the web and HTML is that it's
really WYSIKOWYG (What You See Is Kind-Of
What You Get; thank you Peter Koletzke...)
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/W ADF Faces Component Palette ‘ﬁ/

g Resources

EE) Component Palette L& Resources

* The ADF Faces (e
Component Palette & |
iIncludes icons representing - common components

various User Interface ;g;“:’ncf“mbs

objects Calendar
. @ Choose Color
« Drag-and-drop desired Choose Date

components into the 8 column
Dialog

position desired M) £arns Bt
Layout

€2 Decorative Box
Document

! Inline Frame

4x Navigation Pane

"] Panel Accordion

L4 Panel Border Layout

"] Panel Box
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W Property Inspector g

 When editing Web Pages, the Property Inspector
shows properties for the various “facets” and
components displayed upon the page

& output Text - #{row.Empno} - Prop... (=]
B PH /B (e 3@
= Common
o Id: ot10 v
Rendered: | <default> (true) v |V
3 Value: #{row.Empno} v
= Appearance
NoWrap: <default> (false) vV
TruncateAt: |0 Vv
Description: v
ShortDesc: v “
Rendered: | <default> (true) vl v oo
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W Facets in Structure Window  §

 @-/= Column facets
- @8 af:column - #{bindings.EmpView2.hints.Ename.label}

« The “facets” are

Components that are =B af:column - #{bindings.EmpView2.hints.Job.label}
. /A af:outputText - #{row.Job}
used to contain groups 523 Colum facets
of other components = Sfie
- T_'lfooter
. JDeveIOper > E}E ;-»-'-theader{bd h label}
‘“ ”” . » - -8 aricolumn - #{bindings.EmpView2.hints.Mgr.labe
StrUCtU re” Window A af:outputText - #{row.Mgr}
lists facets in the E}'”T—‘
I
current page - footer
. & header

--E af:column - #{bindings.EmpView2.hints.Hiredate.label}
- @B af:column - #{bindings.EmpView2.hints.Sal.label}
--E af:column - #{bindings.EmpView2.hints.Comm.label}
'-E af:column - #{bindings.EmpView2.hints.Deptno.label}
' Table facets

='wd Panel Collection facets

: & afterToolbar
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Vv 74 Panel and Panel Splitter T

Training Resources

* Pages in ADF are sometimes divided by Panels;
pre-existing templates exist to help create the
number of desired Panels

« Each Panel in turn may be divided into smaller areas
using a Panel Splitter

— By default Panel Splitters split an area horizontally

— Panel Splitters have an “Orientation” property
that allow the split to be vertical
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Wav/ 74 Container Objects (ﬁ/

Training Resources

« ADF provides many “container” objects specifically
designed to hold data objects including:

— Panel Collections are facets that contain other
objects

— Panel Accordions are facets that contain other
objects but shrink-and-grow depending upon
mouse movement

— Tabbed Panels are facets that allow components
to be placed into a tabbed structure
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/W User Interface (Ul) Components (ﬁ/

« Ul Components provided by ADF Faces include:
— Buttons
— Calendars
— Choose Color
— Forms
— Input Text
— Output Text
— Panel Collection
— Submit
— Tables
— more...
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Vav/. 74 Binding Data i

Training Resources

« JDeveloper's interface allows the creation of web
components using drag-and-drop processing

— Drag-and-drop may also be used to associate
View Objects with Ul Components

— This has the effect of “binding” the data to the
data control object
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Vav/ 4 Creating ADF/JSF Faces Pages (ﬁ/

Training Resources

* The following pages walk through the creation of a
simple Web Application using ADF Faces and ADF
BC objects as follows:

1. Design Web Page
2. Create new JSF Page using JDeveloper

3. Add Visual Components to JSF Page

4. Bind Visual Components to ADF BC Objects
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A147 Target Screen Layout i

Training Resources

* Rough design: Department info on the left, list of
Department Employees (for selected department) in
the upper-right, and the information for a single
employee on the lower-right (selected from list)

Department
Info
(read-only, Department Employee List
selectable) (read-only, selectable)
Individual Employee Info
(editable)
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W Create ADF Faces Page f

* To create an ADF Faces page, right-click on an
Application's ViewController Project and choose
“New” to display the “New Gallery” dialog

Appicabon l_JRun Manager =)

% MyADFApplication v & ']
~ Projects QIR V&~
=-{3] Model

+-{2] ViewControll

Edit Project Source Paths...
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Vv New Gallery |

Training Resources

& New Gallery X|

all Features  Current Project Features

This list is fitered according to the current project's selected features

Q Search
Cateqgories: [tems: [ ] Show All Descriptions
(=} General E @ Page ﬂ
Applications
‘_fir actions Launches the Create JSF Page dialog, in which you create a new JavaServer
e - " Faces 2.0 page that can be implemented as a Facelets or JSP document. To
Deployment Descriptors enable this option, you must select a project or a file within a project in the
Java Application Navigator .
Projects )
Yl lﬁ ADF Declarative Component
(=} Business Tier f ADF Page Fraament
Web Services | - -
(= Client Tier (@ ADF Page Template
SWiINg AWT | B8 are c
H['F Skin
Database Tier | [‘a -
= Web Tier @ ADF Task Flow
Applet |
=L X a<k Flow Template
HTML [_ } ADF Task Flow Template
PSF/Facelets &% Composite Component 1
~-JGP ‘
L.Serviets % Facelets Tag Library
Help QK | Cancel

£
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Vav/. 74 Naming Web Page

Training Resources
& Create JSF Page x|

Enter the name and directory, and choose a type for the JSF Page. It can be
implemented as a Facelets or JSP XML document, @

File Mame: |DeptEmpJSFPageljspx |

Directory: |C:\JDeveIoper'\mywork\MyADFAppIicationWiewController'l,public_html | Q

Document Type: () Facelets  (3) ISP XML
Not used in || Render in Mobile Device
demo but Page Layout  Managed Bean

Pmtty cool! () Blank Page

() Page Template

() Quick Start Layout

Two Column Left, Partial Header (Split Left and Stretched)

Browse...

Help QK Cancel

— Note the “JSP XML” Document Type
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Visual Display with Initial Screen }~

Training Resources

& Oracle JDeveloper 11g Release 2 - MyADFApplication.jws : YiewController.jpr

File Edit Vew Application Refactor Search Mavigate Build Run Versioning Tools Window Help

RoEg 90 XEL Q-©O & A4 w- > -&- 1A Qr( search

Application Mavigator * [;] ‘\'})Start Page X |MyADFApp|ication Overview X |@Emp.xml x DeptEmpJSFPage.jspx x E] ﬁCOmponent Palette x [;]
» MyADFApplication '_ M & - | show~ [Match Current Monitor Resolution '] @ \ [None 'IDefauIt 'INone v] \ ;. Q
~I Projects N T-E- preepavesnnvernny : My Components v
=-{0] ViewController [ ] [ td '? l
-] Application Sources - : +| Favorites
=27 Web Content V) : | Recently Used

&) WEB-INF
=l Applicatim;Eesource's
{ {1} Public Synonyms
{3 Schemas
{13 Sequences
{21 Synonyms -
=- {3 Tables
. i BONUS
- Data Controls C T

[B AvADFAppModuleDataControl

H @Facet first - Property Inspector X

-+ Recently Opened Files

5
\
0
L@@l

o Mame *: |First

jspiroot v > Fiview v> af:document#dl v > af:form#f1 w > af:panelsplitter#ps! v > F:facet >

=49 jsproot Design| Source Bindings Preview History <€ ) |]
: (@ isp:directive.page [E]running: Model.jpr - Log X =
= Fiview Q -
: . ctions v
E}“' af :document - DeptEmpISFPage. jspx LLUU] ####s WMELYUULLSULLUL. L4NL LU AUWEYLlUSL -
E}'” af:form [161] ###§# QueryCollection. finl no RowFilter
Bﬂ] af :panelSplitter - horizontal [162] Fail during disconnect.
e :facet - First Feb 7, 201z 7:32:22 PM oracle.jbo.jbotester.MainFrame exit
+E fifacet - second INFO: BC4J Tester exit code(0)
Process exited with exit code 0. :;
Q)
Source | Design Messages | [ Running: Model.jpr ~ ‘4 -

:1)DeveloperimyworkiMyADFApplicationviewControlleriviewController . jpr
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W Quick-Start Layout f

* The supplied quick start layout is ready to have
objects dropped into it (resizing might be needed)

'?)Start Page X ! | MyADFApplication Overview X ,f:E": mi X QDr:-;:ltEranSFPage.jsp:< x E]
— D.
%E) v | Show v |Match Current Monitor Resolution v | |@ 'IE‘»:-F.ault '|None "
- ~]
; 3
[j%p:root v > fiview « > af:document#d! « » af:form#fl « ) af.paneisplitter#ps! « ) f:facet
| Design | Source  Bindings Preview History D ‘
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A4y Layout Components i

Training Resources

‘ADF Faces

* ADF provides several “container”

4] Text and Selection

objects to hold data including:

= Layout

— Panel Accordian @ cxstie

Group
2 Panel Border

— Panel Tabbed S
— Panel Collection u H
— Panel Splitter B

— more ... |
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/W Adding Accordion Component ‘ﬁ/

g Resources

« To add an Accordion Component to the web page
where the individual Dept values will appear and
where the individual Emp values will appear
(left-column and lower-right)

«* Navigation Pane
") Panel Accordion
L4 Panel Border Layout

http://www.kingtraining.com 97 Copyright @ 2012, John Jay King



W Change Accordion Title Property (ﬁ/

o TO alter the Accordlon's @Show Detail Item - showDetailltem 1 -... * @
title, click on the L G @
. . -] Appearance
Accordion and modify o 0 y
Its Property |nspeCtor InflexibleHeight: [100 v
. StretchChildren: | <default> {none) w | v
Text item ) ) o §
(changed to "Depts ) Rendered: | <default> (rue) -]~
Text
o Text: Depts| v
AccessKey: N
TextAndAccessKey: v
ShortDesc: v
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Vav/ 7 Adding Collection Container "

Training Resources :
 Find the “Panel Collection”
component in the Layout ] Panel Box

components and drag it to the Panel Collection
“first” (top) part of the Splitter ' &3 panel Dashboard
area _

=3
¥ | Mone " o

4| %
© &)

jspiroot v » Fiview v ument#dl v » af:form#fl v » af:panelsplitter#ps! v » Rfacet 3
ign | Source Bindings Preview History [I 1
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A7%7 Data Binding: Adding Data, 1~

Training Resources

« To “bind” data to web page components, simply
drag ADF BC data objects to the Visual Editor

« Open the “Application Navigator” and expand the
“Data Controls” accordion to see the ADF BC
components created earlier then drag
“DeptView1” to the “Depts” accordion

~ Data Controls
=\ MyADFAppModuleDataControl

- -3 Deptno

----- &2 Dname
@38 Loc
== EmpView2
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 When prompted;
choose
“Create Forms

-> ADF Read-Only
Form™ to populate the
Department data
display

http://www kingtraining.com
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auge _j ch F
E0Qra »
Graph
Hierarcl
Multiple »
Navigat »
Single S »
Table »
Thematic Map
Tree »
Cancel
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A7#7  Adding Navigation Controls ~ §’

Training Resources

« Check the “Include Navigation Controls™ box

* You may also modify display labels and add, delete,

or reorganize the values displayed
x|

Configure the components that you want to display in your form. Note that vou can remove or edit the resulting

components after you click OK. You can also add more components directly to the layout |ater,

Fields: G@ X

Display Label

_omponent To Use
*& ADF Output Text w/ Label

[v] Include Navigation Controls
[] Include Submit Button

QK Cancel

Help
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W Department Display Area g

 After adding the Department information; the
“Depts” accordion should look like the following

G@ v Show~ |Match Current Monitor Res
Show Detail ltem - Depts

Depts

Deptno  #4.. .Deptno.inputb‘alué:
Dname #{...Dname.inputyalue}
Loc #{...Loc.inputvalue} >

First Previous Next
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A147 Adding Department Employees ‘ﬁ/

Training Resources ‘

* Next, to add Department
Employees to the page, S—

d rag th e E m pV| eWZ d ata =& MyADFAppModuleDataControl
=] DeptView1

control et
........ @ Dname
']I = ot @ | Loc

Create | P
LE S E2 ADF Table... @@ Empno
=N & ADF Read-only Table... @8 Ename

3 ADF Read-Only Dynamic Table @@ Hiredate

Cancel

“Create Tables -> ADF - wgr
Read-Only Table”
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W Add Employee Navigation Controls (ﬁ/
b

« Check all three navigation controls: Row Selection,
Sorting, and Filtering; as before columns may be
relabeled, added, deleted, reorganized

& Edit Table Columns x|
Row Selection
i [v] Enable Sorting
() None — -
) |v| Enable Filtering
() Single Row
() Multiple Rows
Columns: % x
Display Label ‘alue Binding omponent To Use
5@ <default & Empr A ADF Output Text
@ <default =) Ename A ADF Output Text
@ <default = Jot A ADF Output Text
w0 <default> /A _ADF Output Text
[xy: default &2 Deptr & ADF Output Text
xval | IEpu ;}
@
Y
@
Help QK Cancel
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W Department Employee Area g

:rEmpno IEname [Job IHire Date [D
f#{. ..Empno} #{...Ename} #{...Job} #{.. Hiredate} #
E#{ ...Empno} #4...Ename} #4...Job} #4.. Hiredate} A
paly A EGRN o ov o v s BN BEENIEI v v v s B IED b v v v v v o b 0 MiEEdBRG v v 0 B

|Facet center- center = Columns Frozen
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A7%7  Adding Individual Employee  }

* Finally, add the individual )
Employee display to the Accordian = & waorapodeostaconto

=-{E] Deptview1

area at the bottom of the page @ Deptno
. 3 Dname
. &8 Loc
o8
 showDetailltem 1 - L..E@@ Comm
. &3 Deptno
Create L @ Empno
— | Gantts v ADF Read-only Form... . | i..G@ Hiredate
SR & Couges.-. ADF Search Form @ Job
. @@ Sal

« When prompted, choose “Create Forms -> ADF
Form” to select the display format
(this part of the form will be editable)
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A7%7  Add Employee Navigation

Training Resources

\

« Delete the DEPTNO from the display (highlight &

click X); check “Include Submit Button”

Configure the components that you want to display in your form. Note that you can remove or edit the resulting

components after you click OK. You can also add more components directly to the layout later,

Fields:

Display Label

573 <default>
&%) <default>
&3 <default>
573 <default>
&3 <default>
573 <default>
58 <default>

Include Navigation Controls
Include Submit Button

Help

Yalue Binding
= Empno
= Ename
= Job

= Mgr

= Hiredate
= Sal

= Comm

Component To Use

g2 ADF Input Text w/ Label
g2 ADF Input Text w Label
g2 ADF Input Text w/ Label
g2 ADF Input Text w/ Label
{5 aDF Input Date w/ Label
g2 ADF Input Text w/ Label
vm ADF Input Text w) Label

QK

X|

+ X

KW ¢ ® 9

Cancel
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A4 Completed Web Application Page (ﬁ/

Training Resources

Depts jl View v a 4" Detach
Deptno  #4...Deptno.inputvalue’ iTpn: IEname lJOb |H|re De.nte ID
Dname #4...Dname.inputValue} = mpno} #{' - .Ename} #{_' - 'JOb_} #{' ' .Hfredate} i
) #¥4...Empnoy #+...Enamey #4...Job} #4.. Hiredate} #
Loc #{,..Loc.inputvakie} #4.. Empno #4.. Ename! #4...Job} #{.. Hiredate! #
First Previous Mext Columns Hidden Columns Frozen

Empno | #{..Empno.inputalue }
Ename #{..Ename.inputValue}

Job | #{...Job.inputValue}

Magr | #{...Mar.inputialue}

Hire Date |#{..Hiredate.inpL @9

Sal #{..SalinputValue}

Comm | #{...Comm.inputalue}

Submit
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Vav/ 74

Training Resources

fi

Testing the Web Application

To test the Web Application; right-click the

(11 .jSpX”

file in the ViewController project and choose “Run”

B ViewController R
= l::] Application Sources Deptno  #4...Di
| El @ myadf, view Dname #4...Di
P EI DataBindings. cpx Loc #{...Lc
E} @ myadF,view.pageDefs First Previot
- () peptempIsFPagePageDef, xml
=[] META-INF
- [ea] adfrm. sl
' ~[e] adF-settings.xml
El l_:_l Web Content
-] WEB-INF
i #-{_) Page Flows
....... . DeptEszFPage Qpen
J Application Resources . Exclude Project Content
. @ Schemas K Delete
: #-{ 13 Sequences
- Data Controls Deploy ’
l_J {=2] Leptview] [EI Go to Page Definition
e Recently a,e;;aﬁes Find Usages... Ctrl+Alt-U
Refactor »
:‘E DeptEmpJSFPage. jspx - Structy ‘3&' Make Ctrl+Shift-FO
1 é B Rebuild Alt+Shift-FQ
http://www.kingtraining.com . - [E af g Copyright @ 2012, John Jay King




A147 Be Patient! v

g Resources

* The first time you execute a Web application
JDeveloper starts its built-in WebLogic Application
Server; this takes a while

* You can track the progress of the Server's startup in
JDeveloper's DefaultServer Log

(=]Running: DefaultServer - Log
S e e e
<Oct 25, 2009 1:07:52 AM EDT> <Info> <Management> <BEA-141107> <Version: WebLogi]
‘<Oct 25, 2009 1:07:54 AM EDT> <Notice> <WebLogicServer> <BEA-000365> <Server sta
<Oct 25, 2009 1:07:54 2M EDT> <Info@HEei%Ranager> <BEA-002900> <Initializing sS§
<Oct 25, 2009 1:07:55 AM EDT> <Notice> <LoggingService> <BEA-320400> <The log fi
<0Oct 25, 2009 1:07:55 AM EDT> <Notice> <LoggingService> <BEA-320401> <The log fi
<0Oct 25, 2009 1:07:55 AM EDT> <Notice> <Log Management> <BEA-170019> <The server

« Once the Serveris “up” your web page should be
displayed in a browser (again, please be patient!)
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Training Resources

Vav/ Web Page in Browser (ﬁ/

(€ DeptEmpISFPage. jspx | |

Depts View v | 5 = Detach
Deptno 20 | [ | [ @9\
Dname RESEARCH Ename Hire Date Deptno
=i oo _____
First| Previous| Next| Last| 7566 JONES MANAGER 1981-04-02
7788 SCOTT ANALYST 1987-04-19 20
7876 ADAMS CLERK 1987-05-23 20
7902 FORD ANALYST 1981-12-03 20

* Empno 7369
Ename |SMITH

Job [CLERK

Mar | 7902

Hire Date | 1980-12-17
sal | 300
_‘_I Comm |

Submit |
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A4y Files Supporting Application g

Training Resources

« Several files make up the typical ADF Web
Application

— A .jspx file is used to define each web page

— Web pages reference a page definition XML file
(.xml)

— Bindings are described in another XML file (.cpx)
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W JSF jspx File \

« ADF defines a web page using an XML .jspx file

| DeptEmpISFPage.jspx | Ll Emp.xm
[ @8- $4)

7B <f:views

g = <af:document id="dl">

9 <af:messages id="ml"/>

10| = <af:form id="f£1">

11 = <af:pageTemplate viewId="/oracle/templates/threeColunnTenplate.jspx™

12 id="ptl">

13| = <f:facet name="center">

14| = <af:panelSplitter id="psl”™ orientation="vertical':>

15 = <f:facet name="first">

16| = <af:panelCollection id="pcl">

17 <f:facet name="menus" />

18 <f:facet name="toolbar”/>

19 <f:facet name="statusbar”/>

20| = <af:table value="#{bindings.EnpViewzZ.collectionModel}"

21 var="row"” rows="#{bindings.EnpViewZ.range3ize}"

22 enptyText="#{bindings.EnpViewZ.viewable ? 'No data to display

23 fetchSize="#{bindings.Enp¥iewz.rangeiize}"

24 rowBandingInterval="0"

25 filterModel="#{bindings.EnpViewZQuery.queryDescriptor}"”

26 queryListener="#{bindings.EnpView2Query.processQuery}"

27 filterVisible="true” wvaritatus="wvs"

28 selectedRowKeys="#{bindings.EnpViewZ.collectiontodel.selected

29 selectionlistener="#/bindings.Enp¥Viewz.collectionModel.makelCu
ument#dl » afiform#fl » afipagetemplate#ptl » fifacet » afipanelaccordion#pal » af:showdetailitem#sdil 1
Design | Source | Bindings | Preview | History | <! ) > [l
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W ADF Web Page Definition file (.xml))\

= DeptEmpISFPage.jspx | .| DeptEmpISFPagePageDef.xml | 2! Emp.xml S
(@8- $ ) ~ .

1 <?xml version="1.0" encoding="UTF-3" 2>

2| Bl <pageDefinition xmlns="http://xmnlns.oracle.con/adfn/uinodel"

3 version="11.1.1.54.7" id="DeptEnpJ3FPagePageDef”

4 Package="nyadf.view.pageDefs">

5 <parameters />

6| & <executables:

7 <variablelterator id="wvariables"/>

3 = <iterator Binds="DeptViewl” RangeSize="25"

9 DataControl="MyADFippModuleDataControl™ id="DeptWViewlIterator™

10 ChangeEventPolicy="ppr" />

11| = <iterator Binds="EnpView2" RangeSize="25"

12 DataControl="MyADFippModuleDataControl™ id="EnpViewZIterator"

13 ChangeEventPolicy="ppr" />

14| = <searchRegion Binds="EmnpViewZIterator”™ Criteria="""

15 Customizer="oracle.jbo.uicli.binding.JUSearchBindingCustonizer/'

16 id="EnpViewZQuery" />

17 </executables:

18| & <bindings:>

19| = <attributeValues IterBinding="Dept¥iewlIterator” id="Deptno>

20 = <AttrHames:

21 <Item Value="Deptno"”/>

22 < /AttrHames>

23 </attributeValues:-

24| = <attributeValues IterBinding="DeptViewlIterator” id="Dname"> v
Overview | Source | History | ¢ >[I
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ADF Bindings XML file (.cpx)

DeptEmplSFPage.jspx ||| DeptEmpISFPagePageDef.xml  |[)DataBindings.cpx | L2} Emp.xml
@ 1)

WO - G s W N
(1l

N S S R S S S e o
= O W o - s W N O
0] [ (1]

-~

http://www.kingtraining.com

k?xml version="1.0" encoding="UTF-3" 2>
[l <Application xmlns="http://xmlns.oracle.con/adfn/application”

version="11.1.1.54.7" id="DataBindings"™ SeparateXlMLFiles="false"
Package="nyadf.view” ClientType="Generic">
<pageMap’>
<page path=""/DeptEnpJ3FPage. jspx”
usageld="myadf wview DeptEmpJ5FPagePageDef" />
< /pageMap:-
<pageDefinitionUsages:
<page id="myadf wview DeptEmpJ3FPagePageDef"
path="nyadf.view.pageDefs.DeptEnpJ5FPagePageDef™ />
< /pageDefinitionUsages:
<dataControlUsages:
<BC4JDataControl id="MyADFAppModuleDataControl™ Package="myadf.model”
FactoryClass="oracle.adf.model.bcd].DataControlFactoryInpl
SupportsTransactions="true” SupportsFindMode="true”
SupportsRangesize="true”™ 3JupportsResetitate="true”
SupportsiortCollection="true"
Conficquration="MyaADFippModuleLocal”™ syncMode="Imnmediate"
xmlns="http: //xunlns.oracle.con/adfn/datacontrol™ />
< /dataControlUsages:-

22 </Application>
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/W ADF Faces ViewController Files ‘ﬁ/

* The XML files representing =
the ViewController project are = &9 adimsrc

IC2) META-INF
distributed using a directory @gjﬁi’;
= | riev.
structure () pageDefs
= |) classes
= ) .data
) 00000000
=2 ) .wisjsps
) jsp_serviet
) META-INF
= ) myadf
2 5 view
) pageDefs
= |2 public_html
= ) WEB-INF
= ) temp
= ) adf
=2 ) styles
) cache
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W ADF vs. Forms v

Feature Forms | ADF
Declarative database access Yes Yes
Reuse of database access Some Yes
Declarative user interface development Yes Yes
Automatic screen generation Yes Some
Reuse of user interface Some Yes
Web Deployment Yes Yes
Client-Server Deployment No Yes
Fusion Applications development tool No Yes
Customizable Yes Yes
Built with open standards No Yes
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v/ 24 Available Books Iy

* Quick Start Guide to Oracle Fusion Development
— Grant Ronald
— Oracle Press
* Oracle JDeveloper 11g Handbook
— Duncan Mills, Peter Koletzke, Dr. Avrom Roy-Federman
— Oracle Press
* Oracle Fusion Developer's Guide
— Frank Nimphius, Lynn Munsinger
— Oracle Press
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Vav/. 74 Wrapping It Up ¥

 Oracle Forms is not going anywhere; it is not
necessary to “convert” things to ADF
(third-party tools are available to help if you insist)

« Oracle’ s design emphasis and new features will
support the Java-based ADF mechanism; Oracle
Forms probably won’ t see much in the way of

new functionality
« JDeveloper and ADF allow me to create simple
forms almost as easily as in forms except:
- ADF BC (data) creates reusable components
« ADF Faces (view) creates reusable components

| did not write a single line of Java in this demo!
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Please Fill Out Session Evaluations

Oracle ADF for Forms Developers
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King Training Resources
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